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WARNING
This product contains chemicals known to cause cancer, 
birth defects and other reproductive harm, including 
lead. 

For California

WARNING
This is a Class A product. In a domestic environment 
this product may cause radio interference in which case 
the user may be required to take adequate measures.  
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SION RADIO  FREQUENCY  INTERFER-

ENCE STATEMENT

This equipment has been tested and found to comply 
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Part 15 of the FCC Rules.
These limits are designed to provide reasonable protec-
tion against harmful interference when the equipment 
is operated in a commercial environment.
This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause 
harmful interference to radio communications.
Operation of this equipment in a residential area is 
likely to cause harmful interference in which case the 
user will be required to correct the interference at his 
own expense.

Unauthorized changes or modification to this system 
can void the users authority to operate this equipment.

When the equipment requires a usb cable, it must be 
shielded type.

For Canada
CLASS A                    NOTICE
This Class A digital apparatus meets all requirements of 
the Canadian Interference-Causing Equipment Regula-
tions.

CLASSE A                   AVIS
Cet appareil numérique de la classe A respecte toutes 
les exigences du Règlement sur le matériel brouilleur 
du Canada.

For EU Countries

Manufacturer:
ROLAND DG CORPORATION
1-6-4 Shinmiyakoda, Kita-ku, Hamamatsu-shi, Shizuoka-ken, 431-2103 JAPAN

The authorized representative in the EU:
Roland DG Corporation, German Office Halskestr. 7, 47877 Willich, Germany

Roland DG Corp. has licensed the MMP technology from the TPL Group.
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 To Ensure Safe Use

Improper handling or operation of this machine may result in injury or damage to property.
Points which must be observed to prevent such injury or damage are described as follows.

About WARNING and CAUTION Notices

WARNING
Used for instructions intended to alert the user to the risk of death or severe injury 

should the unit be used improperly.

CAUTION
Used for instructions intended to alert the user to the risk of injury or material 

damage should the unit be used improperly.

* Material damage refers to damage or other adverse effects caused with respect to 

the home and all its furnishings, as well to domestic animals or pets.

About the Symbols
The  symbol alerts the user to important instructions or warnings. The specific meaning 

of the symbol is determined by the design contained within the triangle. The symbol at 

left means 

"danger of electrocution."

The  symbol alerts the user to items that must never be carried out (are forbidden). 

The specific thing that must not be done is indicated by the design contained within the 

circle. The symbol at left means the unit must never be disassembled.

The  symbol alerts the user to things that must be carried out. The specific thing that 

must be done is indicated by the design contained within the circle. The symbol at left 

means the powercord plug must be unplugged from the outlet.

 Incorrect operation may cause injury

WARNING
Keep children away from the ma-
chine.
The machine includes areas and compo-
nents that pose a hazard to children and 
may result in injury, blindness, choking, or 
other serious accident.

Never attempt to disassemble, repair, 
or modify the machine.
Doing so may result in fire, electrical 
shock, or injury. Entrust repairs to a trained 
service technician.

CAUTION
Install in a location that is level and 
stable.
Installation in an unsuitable location may 
cause an accident, including a fall or tip 
over.

Be sure to follow the operation proce-
dures described in this documentation. 
Never allow anyone unfamiliar with 
the usage or handling of the machine 
to touch it.
Incorrect usage or handling may result in 
unexpected injury.
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 To Ensure Safe Use

WARNING
Connect to an electrical outlet that 
complies with this machine’s ratings 
(for voltage, frequency, and current).
Incorrect voltage or insufficient current 
may cause fire or electrical shock.

Do not use with any power supply other 
than the dedicated AC adapter.
Use with any other power supply may lead 
to fire or electrocution.

Never use out of doors or in any loca-
tion where exposure to water or high 
humidity may occur. Never touch with 
wet hands.
Doing so may result in fire or electrical 
shock.

Never allow any foreign object to get 
inside. Never expose to liquid spills.
Inserting objects such as coins or matches 
or allowing beverages to be spilled into 
the ventilation ports may result in fire or 
electrical shock. If anything gets inside, 
immediately disconnect the power cord 
and contact your authorized Roland DG 
Corp. dealer.

 Danger of electrical short, shock, electrocution, or fire

Ratings

Never place any flammable object near-
by. Never use a combustible aerosol 
spray nearby. Never use in any location 
where gases can accumulate.
Combustion or explosion may be a dan-
ger.

Handle the power cord, plug, and 
electrical outlet correctly and with 
care. Never use any article that is 
damaged.
Using a damaged article may result in fire 
or electrical shock.

When using an extension cord or 
power strip, use one that adequately 
satisfies the machine’s ratings (for 
voltage, frequency, and current).
Use of multiple electrical loads on a single 
electrical outlet or of a lengthy extension 
cord may cause fire.

When the machine will be out of use 
for a prolonged period, disconnect the 
power cord.
This can prevent accidents in the event 
of current leakage or unintended startup.

Position so that the power plug is 
within immediate reach at all times.
This is to enable quick disconnection 
of the power plug in the event of an 
emergency. Install the machine next to 
an electrical outlet. Also, provide enough 
empty space to allow immediate access 
to the electrical outlet.

If sparking, smoke, burning odor, un-
usual sound, or abnormal operation 
occurs, immediately unplug the power 
cord. Never use if any component is 
damaged.
Continuing to use the machine may result 
in fire, electrical shock, or injury. Con-
tact your authorized Roland DG Corp. 
dealer.
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 To Ensure Safe Use

 Important notes about the power cord, plug, and electrical outlet

Never place any object on top or subject to 
damage.

Never bend or twist with undue force.

Never pull with undue force.

Never bundle, bind, or roll up.

Never allow to get wet.

Never make hot.

Dust may cause fire.
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 To Ensure Safe Use

 The head area becomes hot

WARNING
Never touch the head immediately after 
printing has finished.
Doing so may cause burns.
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 To Ensure Safe Use

 Warning Label

Warning label is affixed to make areas of danger immediately clear. The meaning of the label is 
as follows. Be sure to heed its warnings.
Also, never remove the label or allow it to become obscured.

Caution: High Temperature
Never touch immediately after printing.
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Important Notes on Handling and Use

This machine is a precision device. To ensure the full performance of this machine, be sure to 
observe the following important points. Failure to observe these may not only result in loss of 
performance, but may also cause malfunction or breakdown.

This Machine is a Precision Device.

 Handle carefully, and never subject the machine to impact or excessive force.
 Never print material outside the range of specifications.

Install in a Suitable Location

 Install in a location having the specified temperature and relative humidity.
 Install in a quiet, stable location offering good operating conditions.
 Never use the machine in an environment where silicone substances (oil, grease, spray, etc.) are present. 

Doing so may cause poor switch contact.

When Moving the Machine

 When moving the machine, be sure to support it at the bottom using two hands. Attempting to move the 
machine by holding it at a different location may result in damage.

 When moving the machine to another location, be sure to attach the retainers. Attempting moving without 
attaching the retainers may result in damage.

Printing

 Never attempt to perform printing on the edges or over holes in printing material.
 Printing results may vary according to the original data, the material printed, and the details of settings. 

Before you perform actual printing, we recommend carrying out test printing.
 Attempting printing with no material loaded may damage the pin or heads.
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About Operation Manuals

Documentation Included with the Machine
The following documentation is included with the machine.

 MPX-90 User’s Manual (this manual)
This describes important notes for ensuring safe use, and explains how to install and operate the machine. It 
also explains how to install and operate included software.
Be sure to read it first.

 METAZA Driver Online Help
 Roland METAZAStudio Online Help
 Roland SFEdit2 Online Help
 Dr. Engrave Online Help
You view this documentation on your computer screen. Installing the respective programs makes these avail-
able for viewing. They describe in detail the commands used in the programs.
 P.10, “How to Display Help for Software,” p.11, “How to Display Help for METAZA Driver”

How to Display Help for Software
You can display Help for software by conducting the following operation after installing the software.
 P.26, “Installing the Software”

From [Start] menu, select soft-
ware and click [ Help ].
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About Operation Manual

How to Display Help for METAZA Driver
You can display Help for METAZA driver by conducting the following operation after installing METAZA 
driver.
 P.25, “Installing METAZA Driver”

Procedure

 Windows 7
From [Start] menu, click [Control Panel] → [Hardware and Sound] → [Devices and 
Printers].
Windows Vista
From [Start] menu, click [Control Panel] → [Hardware and Sound] → [Printers].
Windows XP
From [Start] menu, click [Control Panel] → [Printers and Other Hardware] → [Printers 
and Faxes].

 Right click [Roland MPX-90].
Click [Printing Preferences].
The setting window appears.

Continue on the next page
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 Click [Help].
METAZA Driver help appears. 
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1-1 About the Machine

Features
This machine is a metal printer. It prints images by striking detailed points using a marking pin mounted in 
a head. 
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1-2 Names and Functions

This Machine

Main Unit

Cover
Close the cover when making print. 
Hold the middle area of the cover 
as shown in the figure below when 
opening it.

Head unit
Move the head unit and align the 
end handle (marking pin) of the 
head to the surface of material.

Knob
D e te r m i n e  t h e 
h e a d  p o s i t i o n 
based on the sur-
face height of the 
m a t e r i a l  w h e n 
performing print-
ing without using 
a head cap.

Head

Power/Movement button
Pressing this makes the light come 
on and switches on the power. 
Pressing it while the unit is on 
moves the table to the interior of 
the unit and the head to the center 
surface of the table. Pressing it a 
second time moves the head to 
the interior left and the table back 
to the front edge of the unit. To 
switch off the power, you hold 
down the button for one second 
or longer.

Power-code 
connector

USB connector
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1-2 Names and Functions

Chapter 1 Getting Started

Head (MPH-90)

Printing is performed on material using with a 
marking pin. Diamond is attached to the tip of 
the marking pin. Since the head is a consum-
able part, replace it at an appropriate timing.
 P. 99, “The Replacement Cycle for the Head”

Material Retainers

This is used to fix material on a table. Material is 
placed on the adhesive sheet, which then holds 
the material in place. This lets you immobilize 
objects without having to use commercially 
available tape or the like.
 P. 36, “Loading Material Using the Adhesive 
Sheet”

This is a vise made of plastic, and secures 
material in place by clamping it. This makes 
it possible to immobilize material that cannot 
be secured using the adhesive sheet, such as 
items having a curved bottom surface. The act 
of securing an item in place also accurately de-
termines the center position in the horizontal 
direction. 
 P. 41, “Loading Material Using the Center Vise”

Adhesive sheet

Center vise 

Marking pin
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1-3 Checking the Included Items

The following items are packed together with the unit. Make sure they are all present and accounted for.

AC adapter (1) Power cord (1) Head caps (10)
(One installed on the unit by 

default)

Center vise (1) Adhesive sheet (1) Table (1)

USB cable (1) Roland Software Package 
CD-ROM  (1)

Head (MPH-90) (1)
(Installed on the unit by default)

Test-use printing material (4)
(Brass-plated plates) 

User’s manual  (1)
(This document)

Hexagonal wrench (1)
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2-1 Installation

Installation Environment 
Install in a quiet, stable location offering good operating conditions. An unsuitable location can cause accident, 
fire, faulty operation, or breakdown.

CAUTION	 Install in a location that is level and stable.
Installation in an unsuitable location may cause an accident, including a fall 
or tip over.

 Never install in a location subject to wide fluctuations in temperature or humidity.
 Never install in a location subject to shaking or vibration. 
 Never install in a location where the floor is tilted, not level, or unstable.
 Never install in a dusty or dirty location, or out of doors.
 Never install in a location exposed to direct sunlight or near air-conditioning or heating equipment.
 Never install in a location exposed to considerable electrical or magnetic noise, or other forms of electro-

magnetic energy.
 Never install in an environment where silicone substances (oil, grease, spray, etc.) are present.
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Removing and storing the retainers
Retaining materials are attached to protect the machine from vibration during shipment. Remove these after 
emplacement. 
 Remove all Retaining materials. Any that remain may cause faulty operation or breakdown when the power 

is switched on. 
 The retaining materials and package are required when moving the machine to a different location. Store 

them carefully so that they do not get misplaced.

Removing the retainers

The machine is secured at three points (with 5 screws). Remove all the screws and retainers with the provided 
hexagonal wrench.

Continue on the next page

Hexagonal wrench

Screw

Retainer

Retainer

Screws

Screws
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Storing the retainers

Keep the retaining materials by mounting them to the position shown in the figure.
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2-2 Cable Connections

Connecting the machine to a power supply

WARNING	 Do not use with any electrical power supply that does not meet the ratings 
displayed on the AC adapter.
Use with any other power supply may lead to fire or electrocution.

WARNING	 AC Never use any AC adapter and power cord other than the AC adapter 
and power cord included with the machine.
Doing so may lead to fire, electrical shock, or electrocution.

WARNING	 Handle the power cord, plug, and electrical outlet correctly and with care. 
Never use any article that is damaged.
Using a damaged article may result in fire or electrical shock.

WARNING	 When using an extension cord or power strip, use one that adequately 
satisfies the machine’s ratings (for voltage, frequency, and current).
Use of multiple electrical loads on a single electrical outlet or of a lengthy 
extension cord may cause fire.

At this time, the connection to the computer must not be made yet.
Failure to follow the correct procedure may make installation impossible. You make the connection to the 
computer when you install METAZA driver.
 P. 25, “Installing METAZA Driver”

Machine

DO NOT connect a USB cable at this point.

Electrical 
outlet

Power 
cord

AC adapter

Computer 

USB cable
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2-3 Installing the Software

System Requirements

Operating system (*1)

Windows XP Home Edition (32/64-bit edition)
Windows XP Professional (32/64-bit edition)
Windows Vista Home (32-bit edition)
Windows Vista Business (32/64-bit edition)
Windows 7 Professional (32/64-bit edition) (*2)

Processor The minimum required CPU for the operating system
 (At least Pentium 4 3.0 GHz or more recommended)

Memory 
The minimum amount of required RAM for the operating system 
(At least 512MB or more recommended)

Optical drive CD-ROM drive

Video card and monitor At least 16 bit colors (High Color) with a resolution of 800 x 600 or 
more recommended

Free hard-disk space required 
for installation 25MB

(*1)
As this software is a 32-bit application, it runs on WOW64 (or Windows-On-Windows 64) under the 64-bit 
version of Windows.
(*2)
The operation in the Windows XP mode has not been verified.

For the latest information, see the Roland DG Corp. website (http://www.rolanddg.com).

The Software You Can Install and Set Up

METAZAStudio
This is a program for creating printing data. It enables you import 
and crop images to print, and perform editing to add text, boxes, 
and the like.

SFEdit2
This is a program that lets you create and edit stroke fonts. Stroke fonts 
are line drawings created by automatically extracting the centerlines 
from a TrueType font. You can use the generated stroke fonts as fonts 
with METAZAStudio.

MPX-90 Head Manager This is a utility for adjusting the head. Run it when you replace the 
head or adjust the marking pin.

Dr. Engrave
This is text and image printing software that lets you create print 
data. You can use TrueType fonts registered in Windows. It also has 
stroke characters.

METAZA Driver This is a Windows-based driver required for sending data from a 
computer to the machine.
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Installing METAZA Driver

Make sure to connect the machine to a computer by following the given procedure. 
Failure to follow the correct procedure may make installation impossible.

Procedure

 Before you start installation and setup, make sure the USB cable is NOT connected.

 Log on to Windows as “Administrators.”

 Insert the Roland Software Package CD-ROM into the computer.
When the automatic playback window appears, click [Run menu.exe].
The install menu appears automatically.

 Click [METAZA Driver Install].
The Installation and Setup Guide ap-
pears on the screen. When [User Account 
Control] is displayed on the screen, click 
[YES].

 Follow the instructions in the 
Setup Guide to finish installing.
As following the instructions in the Setup 
Guide, you will find the procedure to 
connect the machine to a computer. 
Make sure to keep the instructions given 
below.
 Never connect two or more machines 
to one computer.
 For the USB cable, use the included 
cable.
 Never use a USB hub.
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 Click  of the install menu 
window and setup guide win-
dow. 

Installing the Software
Procedure

  Display the window for the install menu of the software.

 Click [Install] of the program you 
want to install.

 Follow the messages to install the software.
The [User Account Control] appears, click [Allow], and install the softwares.

 When all installation finishes, 
click  of the install menu. 

  Remove the CD-ROM from the CD-ROM drive.
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2-4 METAZAStudio Settings

Making the Setting for the Printer 
After you finish installing and setting up METAZAStudio, continue by making the setting for the printer. Be 
sure to make the setting before use. 

Procedure

 From [Start] menu, click [All Pro-
grams] (or [Programs]) → [Roland 
METAZAStudio] → [METAZAStu-
dio]. 
METAZAStudio starts.

 Click [File] → [Set up the print-
er].
The [Print Setup] dialog box appears. 

 Click the arrow shown in the 
figure, then select [Roland MPX-
90]. Click [OK].
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3-1 Switching the Power On and Off 

Switching On the Power 
Procedure

 Make sure that the stopper contacts the ring and the knob is tightened as shown in 
the figure .
In the case as shown in the figure , loosen the knob to make it into the state shown in the figure 
, and then tighten the knob.

 Press the Power/Movement button.
The lamp of the Power/Movement button is turned ON, and the head moves to the left rear. This opera-
tion is called initialization.

Power/Movement button

The center of the 
knob must be 
positioned above 
this marking.

Knob

Ring

Stopper

OK OK 

Loosen
Tighten

Not OK 
Ring

The center of the 
knob must be 
positioned above 
this marking.
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3-1 Switching the Power On and Off

Description

When the power is ON in the state shown in the figure , there are cases where the power lamp blinks and 
an error occurs immediately after the initial operation is completed. To clear the error, take the procedure  
and press the Power/Movement button. The power lamp stops blinking and lights.

Switching Off the Power
Hold down the Power/Movement button for one second or longer. 
The light goes dark and the power is switched off. 

Power/Movement button

Hold down the button 
for one second or 
longer.
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The Printable Area
The machine's printable area is as follows.

Head Caps 
Using the head cap is usually recommended. 
When the head cap is used, the machine automatically tracks the surface height of material and sets the posi-
tion of the head. Therefore you do not need to set the head position for printing. You can make a print even 
on a cylindrical material. (There is an upper limit of the height that can be tracked.) It is recommended to use 
the head cap for usual printing.
 P. 77, "4-5 Printing on a Curved Surface," p. 98, "The Replacement Cycle for the Head Cap"

Remove dirt and dust from the printing surface.
If you carry out printing without removing dirt and dust attached to the printing surface, it may deteriorate the 
printing quality. Make sure to remove dirt and dust from the printing surface before you perform printing.

For test printing, it is advisable to use materials with no scratches or stains.
Some materials may cause scratches and stains on the head cap during printing, which may affect the print-
ing quality. Scratches and stains on the materials may also damage the head cap and result in poor-quality 
printing. Therefore, for your prior checks on printing, we recommend you perform test printing with materials 
without any scratches or stains.

Center line

Center line

Top view of the table
Printable Area 
50mm × 50mm

Maximum Printable Area (80mm × 80mm)
The setting by METAZA Driver is required.
If an image exceeds the printable area, the print 
result might become uneven in the outside of 
the printable area.

Head cap with 
scratches or 
stains

Scratches or stains caused by the head cap

Printing 
Surface

Scratches
or stains



33Chapter 3 Making Prints

3-2 Getting Ready

Preparing Material to Print
Prepare material that meets all of the following conditions.

Thickness *1

0.3 to 40 mm (0.012 to 1.5 in.)

Size *1

When using the adhesive sheet: 100mm (3.9 in.) (W) × 200mm (7.9 in.) (L) or less, or 200mm (7.9 
in.) (W)× 100mm (3.9 in.) (L) or less.
When using the center vise: 60 mm (2.3 in.) (W) × Length of 200mm (7.9 in.) (L) or less, or 200mm 
(7.9 in.) (W) × 60 mm (2.3 in.) (L) or less. 
*1
Note that you cannot use material which warps during printing even if the thickness and size are within the 
ranges specified above. If you use such material, warped material might come into contact with the head, 
damaging the marking pin. 
The following table shows the printable thickness and size by material.

Material Thickness Width and Length (general guide)
Aluminium 2.0 mm (0.08 in.) Length (or width) of 60 mm (2.3 in.) or less

1.5 mm (0.06 in.) Length (or width) of 40 mm (1.5 in.) or less
1.0 mm (0.04 in.) Length (or width) of 30 mm (1.1 in.) or less
0.5 mm (0.02 in.) Length (or width) of 20 mm (0.7 in.) or less
0.3 mm (0.01 in.) Length (or width) of 20 mm (0.7 in.) or less

Brass or Copper 2.0 mm (0.08 in.) Length (or width) of 60 mm (2.3 in.) or less
1.5 mm (0.06 in.) Length (or width) of 40 mm (1.5 in.) or less
1.0 mm (0.04 in.) Length (or width) of 30 mm (1.1 in.) or less
0.5 mm (0.02 in.) Length (or width) of 15 mm (0.5 in.) or less
0.3 mm (0.01 in.) Length (or width) of 15 mm (0.5 in.) or less

Stainless steel 2.0 mm (0.08 in.) Length (or width) of 60 mm (2.3 in.) or less
1.0 mm (0.04 in.) Length (or width) of 40 mm (1.5 in.) or less

*2
The mounting direction of the vise might be limited.
 P. 41, "Loading Material Using the Center Vise"

Hardness of surface to print

Vickers hardness (HV) of 200 or less *3
*3
Materials which may crack or split by printing (such as glass, stone, precious stones, china, and porcelain) 
cannot be printed even if hardness is within the preceding range.
Attempting to print such materials may damage the machine.
For information of the hardness of the material surface, please contact the shop where you bought the mate-
rial or the manufacturer of the material.



34

3-2 Getting Ready

Chapter 3 Making Prints

Cross-section of printing material

When using an adhesive sheet or a center vice.
 There must be no unevenness on the print surface. *4 

*4
Materials that cannot be used are those of which unevenness comes into contact with the moving part of the 
machine when material is set or when printing is made.

When using an adhesive sheet.
 The back surface must be flat, with no difference in level.

Without a head cap
The printed surface must be level.

Edge of the material is 
too high.

Back surface 
is curved.

Back surface 
is uneven.

Surface to print 
is not straight.

L-shape 

Not OK Not OK 

Not OK Not OK 

Not OK 
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Conditions for Material When Printing Curved Surfaces *5

The table and figure below show the printing-assured area and the area reached by the marking pin with 
respect to the diameter of the cylinder. Note, however, that the following conditions are assumed. 
 The head cap is used. 
 The material has circularity.

Diameter of cy-
lindrical material

Recommended printable area 
(A)

Area reached by the marking 
pin (B)

10 mm (0.3 in.)   2.0 mm (0.079 in.) 2.8 mm (0.11in.)
20 mm (0.7 in.)  2.8 mm  (0.11 in.) 4.0 mm (0.16 in.)
30 mm (1.1 in.) 3.4 mm (0.14 in.) 4.8 mm (0.19 in.)

*5
For printing on curved surfaces, regardless of the shape or composition of the material, the image quality of 
photographic data cannot be assured.
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Loading Material Using the Adhesive Sheet
Procedure 

 Switch on the power
 P.30, "Switching On the Power"

 Make sure that the stopper con-
tacts the ring and the knob is 
tightened as shown in the figure.
Tighten the knob if it is loose. If you make 
a print as the knob is loose, the knob may 
come off due to vibration.

 Attach a head cap to the tip of 
head. 
Mount it as lightly holding the head as 
shown in the figure. The head cap is at-
tached correctly when its tab clicks.

 Set the table.
Fit the tabs on the base of the table to 
the holes of the machine.

Tighten

Ring

Stopper Knob

The center of the 
knob must be 
positioned above 
this marking.

Head cap

Head

Hold the head.

Tab

Fit the tabs here.
Tab
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  Affix the adhesive sheet to the 
table.

 Mount the material on the 
sheet.
Press down lightly on the material to 
secure it in place.

Continue on the next page

Mounting the Adhesive Sheet
 Place it straight, aligned with the scale marks on the table.
 Place inside the table frame.
 Be careful not to allow any air bubbles to form between the adhesive sheet and the table.

Handling of the Adhesive Sheet
 If the adhesive force has been reduced, then wash the adhesive sheet.

 P. 88, "Cleaning the Adhesive Sheet"
 Never rub the surface with force. Doing so may damage the surface and reduce its adhesive strength.

How to Place Material
When material is small enough to be placed within the table

Place the material at the center of the 
scale on the table.

Center Line

Center Line

Material Center of the 
material

Adhesive 
sheet
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If you’re performing printing with head cap used, this completes loading of the material.
If you’re performing printing with no head cap used, then go on to the following steps.

The procedure from this point on is for when you’re not using the head cap.

 Press the Power/Movement but-
ton. 
The head moves and stops at the position 
where the tip of the head cap rides on the 
surface of the material.

 Loosen the knob.
Rotate the knob counterclockwise once. 
Then you can move the stopper. 

When material is too large to be placed within the table
Place the material in a way that the 
center of the printing area comes to 
the center of the scale on the table.
If the material tilts, place a support 
in order to keep the material hori-
zontal.

Center 
Line

Center Line

Material Center of the 
material

Adhesive 
sheet

Stopper

Knob
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  As shown in the figure, move 
the knob to the lowest position.

 Tighten the knob.
Make sure the center of the knob is posi-
tioned properly as pointed by the arrow 
located under the knob.

 Press the Power/Movement but-
ton.
The head moves to the left rear.

 Detach the head cap.

Stopper

Knob

Adjust the position of the knob so that 
its center will come above this marking.

Head cap

Support the head



40

3-2 Getting Ready

Chapter 3 Making Prints

Using the Center Vise 
 With the center vise, you secure material in place by clamping it in the vise. You can also vary the orienta-

tion and front and back sides of the vise when using it. Use it in a way matched to the size and shape of 
the material.
 P. 33, "Preparing Material to Print”

 There are two ways to mount the center vise to the machine, which are vertical mounting and horizontal 
mounting. Select an appropriate way according to the material size and printing area. 

Vise
You can mount the vise 
either with the front side 
up or with the back side 
up.

This is suitable for clamping cylindrical 
material.

This is suitable for clamping plate-shaped 
material.

Horizontal 
direction

Vert ical 
direction

Material 

Center of the 
material

Material 

Center of the print-
ing area
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Loading Material Using the Center Vise
Procedure

 Switch on the power.
 P.30, "Switching On the Power"

 Make sure that the knob is tight-
ened in the state shown in the 
figure.
If it is not in the state shown in the figure, 
loosen the knob, and then tighten it as 
it is in the state shown in the figure. To 
loosen the knob, rotate it counterclock-
wise once. 

 Attach a head cap to the tip of 
head. 
Mount the head as lightly holding it as 
shown in the figure. The head cap is at-
tached correctly when its tab clicks.

 Load the material.
Clamp the material in place in the vise, 
and tighten the retaining screw enough 
to keep the material from easily coming 
loose. Be careful not to overtighten, 
because doing so may damage the 
material.

Loosen

Tighten

Retaining 
screw

Tighten

Ring

Stopper Knob

The center of the knob must 
be positioned above this 
marking.

Head cap

Head

Hold the head.
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 Mount the center vise.
Fit the tabs on the bottom of the center 
vise into the holes in the table on the 
unit.
If the material tilts, place a support in 
order to keep the material horizontal.

If you’re performing printing with head cap used, this completes loading of the material.
If you’re performing printing with no head cap used, then go on to the following steps.

The procedure from this point on is for when you’re not using the head cap.

 Press the Power/Movement but-
ton. 
The head moves and stops at the location 
where the tip of the nose cap touches the 
surface of the material. 

 Loosen the knob.
Rotate the knob counterclockwise once. 
Then you can move the stopper. 

Tab

Tab

Fit the tabs here in the case 
of vertical mounting.

Fit the tabs here 
in the case of hori-
zontal mounting.

Stopper

Knob
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  Move the knob to the lowest 
position as shown in the figure.

 Tighten the knob.
Make sure the center of the knob is posi-
tioned properly as pointed by the arrow 
located under the knob.

 Press the Power/Movement but-
ton.
The head moves to the left rear.

 Detach the head cap.

Stopper

Knob

Adjust the position of the knob so that 
its center will come above this marking.

Head cap

Support the head
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Starting METAZAStudio 

From the [Start] menu, click 
[All Programs] (or Program) 
→ [Roland METAZAStudio] → 
[METAZAStudio].
METAZAStudio starts. 
 P. 45, "METAZAStudio Screen"
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METAZAStudio Screen

Menu Bar
Runs the various commands for METAZAStudio.
 METAZAStudio online help ("Commands")

Toolbar
The toolbar is provided with buttons for 
running METAZAStudio commands such as 
[Material] and [Open].
 METAZAStudio online help ("Commands" 
> "Toolbar buttons")

Table
The unit’s table is shown 
here. The scale displayed 
represents the actual scale 
marks on the table.

Work Area
This is the area in which 
printing is possible. The 
workpiece size (print-
ing area) set with the 
Windows-based driver is 
shown here.
 P. 83, "METAZA Driver 
settings"

Centerline
This indicates the verti-
cal center location of the 
window.

Centerline
This indicates the hori-
zontal center location 
of the window.

Grid Pitch
This displays the pitch 
(spacing) of the grid 
lines. Clicking the right 
mouse button over this 
displays menu items re-
lated to the appearance 
of the grid. 

Grid
This is a grid of lines dis-
played in the work area. 
It serves as a guide for 
positioning images and 
text.

View Scaling Factor
This displays the pres-
ent scaling factor for the 
screen view. Clicking the 
right mouse button over 
this displays a menu that 
lets you change the view 
scaling factor.

Present Cursor Position
This indicates the present loca-
tion of the cursor. The position 
at the center of the window 
(where the two centerlines 
intersect) is (0, 0).

Margin
This is a blank area where 
no printing is performed 
that lies inside the edges 
of the work area. It is set 
at 1 millimeter by default. 
You can change the size of 
the margin by going to the 
[File] menu and selecting 
[Preferences]. 
 P. 46, "Step1 : Determine 
the shape and size of mate-
rial," p. 77, "Step1 : Decide on 
the Printing Area (Workpiece 
Size)"

Status Bar
This shows the present location of the cursor, information about the shape, the grid, and the view magnification. Moving 
the pointer to a toolbar button or pointing to a menu command makes a brief explanation of the button or command 
appear at the left edge.
Note : Shape Information
This appears when you click an on-screen object (image, text, or shape). The center position and size of the present shape 
are displayed, as shown in the figure below.
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Step1 : Determine the shape and size of material.
This section explains the shape and size of material to be determined by METAZAStudio when using the plate 
as explained below. METAZAStudio has a number of different types of material preregistered. Use the material 
with the “tag” name, which has the same shape as the plate used
 P. 33, "Preparing Material to Print"

 When you want to print on cylindrical material and other curved surfaces, 
see the section given below.
 P. 77, "4-5 Printing on a Curved Surface"
 If you want to register new material, see the section given below.
 P. 82, "4-6 Register New Material"

Procedure

 Click .
The [Material] window appears. 

 

40 mm

25 mm
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  Click the icon with the “tag” 
name. 

 Click .
The [Material Size] dialog box appears.

 Enter the values for the size of 
the material.

 Click [OK].
The material you selected appears in the 
Edit window. The portion displayed as 
the material becomes the printing area 
without change.

 Click [File] → [Preference].
The [Preferences] dialog box appears.

Material window

Edit window
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  Set “Margin” to “1 mm.”
 Click [OK].

For printing on a flat plate, make the 
margin at least one millimeter. Other-
wise the marking pin may strike and 
damage the edge of the material.

Step2 : Import the Image 
Here you import an image (such as photograph or drawing) for printing.

Data formats supported by METAZAStudio
 Files in JPEG format
 Files in BMP (bitmap) format
 Files in AI or EPS format created by Illustrator version 7 or 8
 Files in AI or EPS format exported by CorelDRAW version 7 or 8
Note : Illustrator and CorelDRAW files are subject to a number of limitations. For details, see the online help 
for METAZAStudio.
 METAZAStudio online help ("Hints and Tips" > "Reusing Existing Data")

Procedure

 Click .
The [Import] dialog box appears.
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  At [Look in], select the location 
of the file.

 At [Files of type], select either 
[Picture file] or [Adobe Illustrator 
file]. 

 Select the file you want.
 Click [Open].

The specified image is imported and 
displayed with the margins you set. 

You can vary the arrangement of the 
placed image, such as by changing its 
size or orientation or by adding borders 
around it.
  P. 58, "4-1 Tips and Tricks for Image 
Layout"

If the material has holes, take care to ensure that the image is not laid out over the holes.  If you include 
the holes in the printing area, the marking pin might hit the edge of the material, damaging it.

 P. 59, "Adjusting the Location, Size, or Angle of an Image"

1mm 
( 0.04 in. )

1mm 
( 0.04 in. )

The printing area 
lies over a hole.

No margins are 
present at the edges 
of the material. 

The printing area 
extends beyond 
the material.

Printing area

Not OK OK Not OK Not OK 

Printing area Printing area Printing area
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Step3 : Enter the Text
Here you type in the text to print. 

Procedure

 Click .

  Click on the printing area.
 Type in the text.

You can change the size and orientation 
of the typed text and fill it.
 P. 64, "4-2 Tips and Tricks for Text Lay-
out" 

Step4 : Save Printing Data
Save the printing data in a file.

Procedure

 Click .
The [Save As] dialog box appears.



51Chapter 3 Making Prints

3-3 Preparing Print Data (METAZAStudio)

  For [Save in], specify where to save 
the file. 

 Type in a file name.
 Click [Save]. 
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Starting Printing
Important!

Never attempt printing in any of the following situations.
 When no material is loaded
 When the head is not set at an appropriate position based on the surface height of the material in the case 

that you do not use the head cap.
 P. 36, "Loading Material Using the Adhesive Sheet," p. 41, "Loading Material Using the Center Vise"

Procedure

 Close the cover.

 Click 
The [Print] dialog box appears.

  Make sure [Roland MPX-90] is 
chosen as the printer name.

 Click [Properties].
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  Click the [Image Correction] 
tab.

 Select [Material].
Select either the composition or the 
product code of the material.
You can adjust and register the striking 
force.
  P. 92, "Registering a Composition and 
Adjusting the Striking Force"

 Select Print mode.
  P. 92, "Registering a Composition and 
Adjusting the Striking Force," METAZA Driver 
online help ([Correction] tab)

 Click [OK].

 Click [OK].
The printing data is sent to the machine 
and printing starts.

 After printing has finished, open the cover and detach the material.
Do not open the cover until the operation is completely stopped.
If the material is difficult to detach when using the adhesive sheet, inserting a thin, flat object (such as 
a piece of stiff paper or cardboard) between the adhesive sheet and the material may make it easier to 
dislodge.
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Stopping Printing Operations

Hold down the Power/Movement 
button for one second or longer. 
The light slowly blinks while the transmit-
ted print data is being deleted. The light 
goes dark and the power is switched 
off. 

You can delete the print data with the following method.

Procedure

 Windows 7
From [Start] menu, click [Control Panel] → [Hardware and Sound] → [Devices and 
Printers].
Windows Vista
From [Start] menu, click [Control Panel] → [Hardware and Sound] → [Printers].
Windows XP
From [Start] menu, click [Control Panel] → [Printers and Other Hardware] → [Printers 
and Faxes].

 Double-click the [Roland MPX-90] 
icon.

 At the [Printer] menu, click [Can-
cel All Documents] (or [Purge 
Print Documents]).

Power/Movement button
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 If the message shown in the figure 
appears, click “Yes.”



56



57

Chapter 4  
More Advanced  
Operations

4-1 Tips and Tricks for Image Layout............................................58

Keeping Only the Required Portion of an Image (Trimming) .....58

Adjusting the Location, Size, or Angle of an Image....................59

Enclosing an Image in a Frame..................................................62

4-2 Tips and Tricks for Text Layout...............................................64

Adjusting the Location, Size, or Angle of a Text.........................64

Arranging a Text to a Fan Layout ..............................................66

Laying Out Text along a Shape..................................................67

Filling Text...................................................................................68

4-3 Creating and Editing Line Text................................................70

SFEdit2 window..........................................................................70

Creating a Stroke Character Font...............................................71

Changing Input Characters into Stroke Characters....................73

Editing Stroke character.............................................................74

4-4 Checking and Adjusting Finished Result of an Image............75

Checking the Finished Results in the Preview Window.............75

Adjusting the Finished Result in the Preview Window...............76

4-5 Printing on a Curved Surface.................................................77

Step1 : Decide on the Printing Area (Workpiece Size) ..............77

Step2 : Make horizontal writing on portrait material...................80

4-6 Register New Material............................................................82

How to Register Wide Variety of Material...................................82

4-7 METAZA Driver Settings.........................................................83

Keeping the settings of METAZA Driver.....................................83

4-8 About Dr. Engrave..................................................................84

What is Dr. Engrave?..................................................................84

Points to note when using Dr. Engrave......................................84

4-9 More Advanced Other Operations..........................................85

More Advanced Other Operations You Can Accomplish with 
METAZAStudio...........................................................................85



58 Chapter 4 More Advanced Operations

4-1 Tips and Tricks for Image Layout

Keeping Only the Required Portion of an Image (Trimming) 
METAZAStudio can cut an original image to remove unneeded areas and keep just the required portion. This 
operation is called “trimming.” 
In this example, you use the printing data created from page 46 to 48.

Procedure

  Click .
 Click the image.

Eight trimming bars appear around the 
image.

 Trimming
Drag the trimming bar to trim the area 
you want to keep.

Trimming bar
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Adjusting the Location, Size, or Angle of an Image
METAZAStudio can change the location, size, and angle of a placed image to achieve the layout you want. In 
this example, you use the printing data created at page 58, “Keeping Only the Required Portion of an Image 
(Trimming).”

Procedure

  Click .

  Click the image.
Handles (■) appear at the four corners 
of the image.

 Drag the image to adjust its 
location.
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 Drag the handles at the four cor-
ners of the image to adjust the 
size.

 With the handles present at the 
four corners of the image, click 
the image a second time. 
The shape of the handles at the four 
corners changes to (●).

 Line up the pointer with a 
handle.
The shape changes to a pointer for rota-
tion.

Handles

Pointer for rotation
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 Drag to adjust the angle of the 
image.

 Holding down the keyboard’s SHIFT key as you drag makes the angle change by 45 degrees at a time. 

Using this method can be convenient at times such as when you want to perform rotation by precisely 

90 degrees.

 Trimming cannot be performed for an image whose angle has been changed. To perform trimming, 

first return the image to its original angle.
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Enclosing an Image in a Frame
You can change the arrangement of printing data by placing a frame around an image. You use frames reg-
istered in what’s called METAZAStudio’s “library.” The library contains a number of preregistered frames, and 
you can also register new ones.
 METAZAStudio online help (“Hint and Tips” > “Making Use of Library” )

In this example, you add a frame to the printing data created at page 55, “Adjusting the Location, Size, or 
Angle of an Image.”

Procedure

 Click .
The [Library] window appears.

  From [Group], select [Frame].
 Select [Icon].
 Click the [04] frame.
 Click .

A flame is inserted into the window. 
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 Adjust the size and location of 
the frame.
When the size of the frame is larger than 
that of material, the result becomes as 
shown in the figure. The adjustment 
methods are the same as the methods 
for adjusting the location and size of an 
image.
 P. 59, “Adjusting the Location, Size, or Angle 
of an Image“

Frame

Handles
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Adjusting the Location, Size, or Angle of a Text
You can change the location, size, and angle of a placed text same as image.

Procedure

  Arrange the text horizontally.
 P. 50, “Step3 : Enter the Text”

 Click .
 Click the laid-out text.

Eight handles appear around the text.
 Drag the text to adjust its lo-

cation.

 Drag the handles to adjust the 
size.
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   Click on the text and hold until 
the shape of the handles at the 4 
corners changes to [●].

 Line up the pointer with a 
handle.
The shape changes to a pointer for rota-
tion.

 Drag to change the angle of 
the text.

Holding down the keyboard’s SHIFT key as you drag makes the angle change by 45 degrees at a time. 
Using this method can be convenient at times such as when you want to perform rotation by precisely 
90 degrees.
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Arranging a Text to a Fan Layout 
You can arrange a text to a fan layout. 

Procedure

  Enter text.
 P. 50, “Step3 : Enter the Text”

 Click .
The [Properties] dialog box appears.

  Click the Format tab.
 Select the [Align with Curve] 

check box.
 Click [OK].

The layout of the text changes to a fan 
shape.
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Laying Out Text along a Shape
Here you lay out text along a shape you have made using the drawing tools.

Procedure

  Click a drawing tool.
In this example you use  . 

 In the editing window, create a 
shape on the material.
 METAZAStudio online help (“Commands” 
> “Toolbar buttons” ) 

  Click  .
 Position the pointer near the 

outline of the shape you created, 
and when appears under the 
pointer, then click .

Drawing tools
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 Enter text.
 P. 50, “Step3 : Enter the Text”
The text is laid out along the shape.

Important!

Layout on an integrated polyline is not possible.
 METAZAStudio METAZAStudio online help (“Commands” > “[Object] menu” > “Convert to Polyline,“ “Integrate 
Polyline” )

Filling Text
There are two ways to fill text: [Fill] and [Island Fill]. Select either way according to your preference.

Fill
Text is filled without 
space.

Island Fill
You can specify the 
interval between adjacent 
filling lines.



69Chapter 4 More Advanced Operations

4-2 Tips and Tricks for Text Layout

Procedure

  Enter the text.
 P. 50, “Step3 : Enter the Text”

 Click .
The [Properties] dialog box appears.

  Click the [Fill and Contour] 
tab.

 Select the [Fill] check box.
 Select [Fill] or [Island Fill].

When you select [Island Fill], you need 
to enter Pitch as well. Pitch is the interval 
between adjacent filling lines.

 Click [OK].
The text is filled.

Important!

When you make a print with a lot of lines (Island Fill, etc.) on aluminum material and the like, the unevenness 
of the material surface is increased, and consequently the head cap becomes worn out faster. Check the state 
of the head cap regularly so that it can be replaced at an appropriate timing. 
 P.98, “The Replacement Cycle for the Head Cap”
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4-3 Creating and Editing Line Text

SFEdit2 is software to create and edit stroke character fonts. On METAZAStudio, you can use the stroke char-
acter fonts that are created and edited by SFEdit2.

SFEdit2 window

Menu Bar
Runs the various commands for SFEdit2.
 SFEdit2 Help (”Commands”)

Toolbar
The toolbar is provided with buttons for running 
SFEdit2 commands such as [Open...] and [Save]. 
 SFEdit2 help (“Commands” > “Toolbar but-
tons”)

Character List
This displays the list of all 
stroke characters.
To edit the stroke charac-
ter, click it.

Text box
This is a box for enclos-
ing text.
The size of the box differs 
according to the type of 
base font and the charac-
ter. Normally you should 
create the text so that it 
fits inside the box.

Stroke Characters
All stroke characters are made up of polylines 
and lines.
You can edit them by adding or deleting verti-
ces, adding line segments, and so on.
 SFEdit2  help (”Operation Procedures” > 
”Step2: Edit the shape of character”)

Base line
This is the reference line for lining up 
a text string horizontally.
When text is written horizontally, the 
base lines of adjacent characters are 
lined up along a horizontal line so that 
there is no unevenness.

Status bar
Moving the pointer to a toolbar button or 
pointing to a menu command displays a brief 
explanation of the button or command.

Base font text
This is displayed as a rough draft for 
editing stroke characters.
A base font serves as the design base 
for a stroke character.
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4-3 Creating and Editing Line Text

Creating a Stroke Character Font
The method of creating and saving a stroke character font is explained below.

Procedure

 Starting METAZAStudio.
 P. 44, “Starting METAZAStudio”

 Click [Edit] → [Stroke Font] → 
[Run SFEdit2…].
SFEdit2 starts.

 Click [File] → [New…].
[Select Base Font] dialog box appears.

  Select a font which is used as 
a base of a stroke character font 
to be created.

 Click [OK].
A stroke character font is automatically 
created.
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 Click .
[Save] dialog box appears.

  Enter a name of the created 
stroke character font.

 Click [OK].
The created stroke character font is 
saved.

 Click . 
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4-3 Creating and Editing Line Text

Changing Input Characters into Stroke Characters
This section explains the method of changing input characters into stroke characters using a stroke character 
font.
To use a stroke character font, either of the following operations must be done in advance.
 Create a stroke character font before SFEdit2 is installed.
 Create a new stroke character font.
 P. 71, “Creating a Stroke Character Font”

Procedure

 Enter the Text
 P. 50, “Step3 : Enter the Text”

 Click . 
The [Properties] dialog box appears.

  Click [Format] tub.
 Select [Stroke character].

The option of [Font] becomes Stroke 
character only.

 Select Stroke character.
 Click [OK].

Input characters become stroke char-
acters.
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Editing Stroke character
Using SFEdit2, you can edit the shape of a created stroke character. The procedure to edit a stroke character 
using SFEdit2 is explained below.

Procedure

 Change an input character to a stroke character.
 P. 73, “Changing Input Characters into Stroke Characters”

  Click the stroke character you 
want to edit.
Eight pointers appear around the stroke 
character.

 Click [Edit] → [Stroke Font] → 
[Edit Stroke…].
SFEdit2 starts.

  From Character List, click 
stroke character you want to 
edit.
The stroke character you want to edit is 
displayed in Text box.

 Edit the stroke character.
Change the position and shape of the 
stroke character.
 SFEdit2 help (“Editing Polylines”)

  Click .
The edit is overwritten to the selected 
stroke character font.

 Click . 
SFEdit2 is finished.
The edit is reflected to the stroke char-
acter.

Text box
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4-4 Checking and Adjusting Finished Result of an Image

Checking the Finished Results in the Preview Window
Checking the Finished Results in the Preview Window

Click .
Preview window appears.

Preview window
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Adjusting the Finished Result in the Preview Window
At the preview window, you can adjust the brightness, contrast, and gamma correction. An image with clearly 
defined light and dark areas produces attractive printed results.

 Brightness
This adjusts the overall brightness. 
Making the value too large can destroy 
the balance, so it may be a good idea 
to adjust it to the absolute minimum 
necessary.

 Contrast
This mainly adjusts highlights (the bright-
est areas) and shadows (the darkest ar-
eas). Using this can be effective when you 
want to achieve a sense of tension with a 
good balance of light and dark.

 Gamma
This mainly adjusts the brightness 
of tones of intermediate brightness 
between bright and dark areas. Using 
it is effective in adjusting the overall 
brightness.

The dark and bright areas are printed as 
shown in the figure.
Dark-color areas are not struck, and light-
color areas are struck forcefully.

Also, the printing results before and after 
adjustment are as shown below.

Dark Area

Bright area

Before adjusting After adjusting

Adjust the gamma to 0.4.
The brightness of the face is reduced, and 
the facial expression becomes clear.

Preview window
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4-5 Printing on a Curved Surface

With this machine, using a head cap lets you perform printing on cylinders and other examples of material 
whose surface height is not uniform. This section describes how to create data, using printing on a cylindrical 
material like the one shown below as an example.

Step1 : Decide on the Printing Area (Workpiece Size) 
First, you make the settings for the printing area on the material. In the case of printing on cylindrical mate-
rial, printing over the entire surface of the material (as on flat material) is not possible. For this reason, the 
METAZAStudio editing window displays the printing area instead of the material. The printing area is determined 
by the value of the material’s diameter entered at the setting window for the driver. For more information about 
the conditions of cylindrical material that this machine can print, refer to the page indicated below.
“Conditions for Material When Printing Curved Surfaces” in “P. 33, “Preparing Material to Print”

Procedure

 Click [File], then click [Prefer-
ences]. 
The [Preferences] dialog box appears.

50mm 

10mm 



78

4-5 Printing on a Curved Surface

Chapter 4 More Advanced Operations

  Set “Margin” to “0 mm.”

 Click [OK].

 Click [File], then click [Set up the 
printer].
The [Print Setup] dialog box appears.

When you’re printing on cylindrical 
material, set the margins to zero mil-
limeters. When printing on cylindrical 
material, the makeable area is limited, 
and so a sufficient printing area must 
be ensured by making the margins 
zero millimeters in size. 
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4-5 Printing on a Curved Surface

  Make sure [Roland MPX-90] is 
chosen as the printer name.

 Click [Properties].

  Click the [Material] tab.
 Set [Diameter] to 10 millime-

ters.
 Select [Direction].

Make horizontal writing on portrait 
material.

 Vertical

 Horizontal
In this example, select (vertical).

 Click [Enter].
Under [Work Size], the value for [Width] 
is set automatically. 
For [Length], in this example, make the 
setting of 50 millimeters.

 Click [OK].

 Click [OK]. 
This is the end of the printing area set-
ting.
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Step2 : Make horizontal writing on portrait material.
After the printing area is determined, place images and text on the area.
This section explains the method of inputting characters horizontally on portrait material.

Procedure

  Type in the text to print, then 
adjust how it’s laid out.
 P. 50, “Step3 : Enter the Text”

 Change the text size to any size 
of your preference.
It must be fit within the printing area.
 P. 64, “Adjusting the Location, Size, or 
Angle of a Text” 

 Rotate the input character to make 
it vertical.
 P. 64, “Adjusting the Location, Size, or 
Angle of a Text”
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4-5 Printing on a Curved Surface

  Click . 
 Press the <→> key on the 

keyboard.
The result becomes as shown in the 
figure.

  Enter text remained.
 Move the text to any position 

of your preference.
 P. 64, “Adjusting the Location, Size, or 
Angle of a Text” “

The on-screen table scale corresponds to the scale for the center vise as shown in the figure. Adjust the 
position of the material to enable the text to be printed at the location you want. 

 P. 41, “Loading Material Using the Center Vise“
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4-6 Register New Material

How to Register Wide Variety of Material
METAZAStudio includes preregistered material of four shapes. To print material not registered in METAZAStudio, 
first register it as a new material. This prevents the printing area from being limited and the marking pin from 
being damaged as the result of hitting the edge of material.
The following three methods are available for registering material. For detailed information about the proce-
dures, refer to the online help for METAZAStudio.
 P.10, “How to Display Help for Software“
 METAZAStudio online help (“Hint and Tips” > “Registering Favorite Material”)

Importing a bitmap image

If an image of the material is available, you can import the image. Note, however, that only bitmap data can 
be used. Other requirements are as follows. 
 File format : Must be either BMP (bitmap) or JPEG
 Number of colors : Binary (black and white — portions corresponding to the material must 

be black-filled)

Scanning the material with a commercially available scanner

When no image of the material is available, or the shape of the material is complex, you can scan the material 
on a commercially available scanner and import the image produced. In this regards, the requirements are 
as follows.
 Scanner : Scanner that supports TWAIN_32.
 Number of colors : Binary (black and white — portions corresponding to the material must 

be black-filled)

Drawing the shape of the material

If the material is a square, circle, or other such simple shape, either singly or in combination, you can use the 
drawing tools to draw the shape of the material, then register it.
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4-7 METAZA Driver Settings

Keeping the settings of METAZA Driver
At the setting window for METAZA driver, you can make the settings for a wide variety of items, including the 
size of the material and the method used for printing. Any changes you make at this window (the window 
displayed by using the procedure described here) remain in effect even after you restart METAZAStudio.

Procedure

 Windows 7
From [Start] menu, click [Control Panel] → [Hardware and Sound] → [Devices and 
Printers].
Windows Vista
From [Start] menu, click [Control Panel] → [Hardware and Sound] → [Printers]. 
Windows XP
From [Start] menu, click [Control Panel] → [Printers and Other Hardware] → [Printers 
and Faxes]. 

  Right-click [Roland MPX-90].
 Click [Printing Preferences].

The setting window for METAZA Driver 
appears.

Going to the METAZAStudio [File] menu and clicking [Print Setup], then, in the [Print Setup] window, 
clicking [Properties], displays the same window as the one that appears using “Displaying the Setting 
Window,” described above. Any changes you make while at this window disappear when you restart 
METAZAStudio. It is recommended to use this window when you temporarily change the METAZA 
driver settings.
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4-8 About Dr. Engrave

What is Dr. Engrave?
Dr. Engrave is printing software for plate materials.
It can read a text file in which data is separated by commas or tabs into the character field. You can use the 
files created with spreadsheet software and database software which have the text write function.
For more information, see Help of Dr. Engrave.
 P. 10, “How to Display Help for Software”

Points to note when using Dr. Engrave
 Setting of the material size (or the print area size) must be done in the setting window for METAZA 

Driver.
 P. 83, “METAZA Driver Settings.”

 Set the material in a way that the center of the material (or the print area) comes to the center of the table 
(or the center vise).
 “How to Place Material” in P. 36, “Loading Material Using the Adhesive Sheet,” p.41, “Using the Center Vise“
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4-9 More Advanced Other Operations

More Advanced Other Operations You Can Accomplish with METAZAStudio
METAZAStudio has some further useful functions, which are not explained in this document. Major functions 
are given below. For more information on how to operate METAZAStudio, refer to the online help for the 
program. 
 P. 10, “How to Display Help for Software”

Make images of people more prominent

When the machine prints data created using METAZAStudio, light and dark are expressed by making colors 
close to white darker and colors close to black lighter. This means that dark hair or clothing may be printed 
light, making the outline of the person indistinct. (Depending on the data, such hair or clothing may not be 
printed at all.) In such cases, cropping the person and applying a border to the image enables you to make 
the image of the person stand out better when printed.
  METAZAStudio online help (“Operation Procedures” > “Step 3: Delete Unnecessary Parts from Image” ) 

Register often-used shapes and images in advance

You can register often-used and generic-use shapes in the library, which enables you call them up and add 
them to your data whenever you need them. Registering logos and other graphics can add convenience. You 
can also register images.
 METAZAStudio online help (“Hints and Tips” > “Making Use of Library”)

Create contour lines from images

You can print imported images with added contour lines. The data formats that you can import are JPEG and 
BMP (bitmap). To enable clean extraction of the contours, the data should meet the following conditions.
Gradations : Use images that do not contain continuous gradations and that have clearly defined 
borders between colors. ]
Number of colors : Binary (black and white [recommended]) 
Resolution : High (Note, however, that the optimal resolution may vary according to the com-
plexity of the shape and the size when printed.)
 METAZAStudio online help (“Hints and Tips” > “Creating Contour Lines from an Image”)

Share files over the Internet

You can save images that contain material shapes as bitmap (BMP) files. You can then send the files over the 
Internet for confirmation of the finished results.
 METAZAStudio online help (“Hints and Tips” > “Creating Preview for Customers to Check Completion Image”)

Optimize photograph images

You can automatically adjust the colors of a photograph image into those suitable for printing from MPX-90. 
This function is effective for a photograph image which uses a lot of colors.
 METAZAStudio online help (“Operation Procedure” > Step 2: Load and Image)
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5-1 Daily Care

Points to Note on Daily Care

WARNING	 Never use gasoline, alcohol, thinner, or any other flammable material. 
Doing so may cause fire.

CAUTION	 Never touch the heads immediately after printing has finished.
Doing so may cause burns.

 This machine is a precision device, and is sensitive to dust and dirt. Be sure to carry out 
day-to-day cleaning.

 Never use solvents such as thinner, benzine, or alcohol.
 Never attempt to oil or lubricate the machine.
 Never apply silicone substances (oil, grease, spray, etc.) to the machine. Doing so may cause 

poor switch contact.

Cleaning the Adhesive Sheet
Buildup of dust or the like on the adhesive sheet can reduce the sheet's adhesive force, making it difficult to 
secure material in place. If the adhesive force has been reduced, then wash the adhesive sheet.

How to Wash

Immerse the adhesive sheet in water, and wash the sheet by gently stroking its surface. If the soiling of the 
adhesive sheet is severe, wash it using diluted neutral detergent. Rinse thoroughly with water to remove all 
detergent completely.

Be sure to comply with the following instructions.
If not, the surface of the adhesive sheet is damaged, lowering the adhesiveness. 
 Never scrub the adhesive sheet using a scrubbing pad or sponge.
 Never stretch or bend the adhesive sheet when washing it.

How to DRY

Allow to dry completely, out of direct sunlight.
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5-1 Daily Care

Cleaning the Body and Cover 
Use a cloth moistened with water then wrung well, and wipe gently to clean. 
The surface of the cover is easily scratched, so use a soft cloth. 

Cleaning of the Head Cap
Detach the head cap mounted on the machine and remove dirt and dust inside the head cap. Printing without 
removing dirt and dust from the head cap may damage materials and/or affect the print quality.
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5-2 Adjusting the Marking Pin

Checking the State of the Marking Pin
MPX-90 Head Manager indicates the amount of pin usage.
When the indicator is shown in red, replace the head with a new one. Even when the indicator is not displayed 
in red, if the print quality is not satisfactory or the unevenness of the printed image persists, replace the head 
with a new one.
 P. 100, "How to Replace the Head," p. 105, "The printed image is unattractive," p. 106, "The image is uneven"

Procedure

 From [Start] menu, click [All Programs] (or [Programs]) → [MPX-90 Head Manager] → 
[MPX-90 Head Manager].
MPX-90 Head Manager starts.

 Switch on the power to the machine.
 P. 30, "Switching On the Power"

The amount of pin usage is indicated 
in this window. The level indicator 
increases little by little as the pin is 
used to strike the material. The rate 
of increase varies depending on the 
material used for printing. When the 
indicator is displayed in red, it is time 
for replacement of the head.

This refreshes the screen to display 
the latest information.
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5-2 Adjusting the Marking Pin

Adjusting the Striking Force of the Pin
You can adjust the striking force of the pin by using MPX-90 Head Manager. Pin adjustment involves striking 
the pattern shown in the figure. Prepare a piece of test-use printing material (brass) or other material measur-
ing about 60 mm (2.3 in.) by 60 mm (2.3 in.).

Procedure

 From [Start] menu, click [All Programs] (or [Programs]) → [MPX-90 Head Manager] → 
[MPX-90 Head Manager].
MPX-90 Head Manager starts.

 Switch on the power to the machine.
 P. 30, "Switching On the Power"

 Click [Readjust Pin].
Follow the on-screen instructions to 
perform adjustment for the pin.

Set a material using the adhesive sheet 
and table.

  P. 36, "Loading Material Using the Adhesive 
Sheet"
Print the adjustment pattern using the 
head cap.

  P. 36, "Loading Material Using the Adhesive 
Sheet"
If the adjustment pattern fails to be 
printed, see the sections given below.

  P. 104, "The printed location isn't where 
desired," p. 105, "Striking is performed, but 
nothing is printed"

 When you have finished, click
.

The window closes.

Adjustment 
pattern
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5-3 Composition Registration and Striking-force Adjustment

Registering a Composition and Adjusting the Striking Force
Here you register a composition and adjust the striking force to match its hardness and other parameters.
With this machine, performing printing using a striking force appropriate to the composition of the material 
used can obtain printing results of even higher quality. The driver for the machine has premade settings for a 
number of compositions and their appropriate striking forces, but you can also register compositions and their 
optimal striking forces yourself. You can also carry out later adjustment of the striking force of compositions 
you’ve registered yourself, in order to obtain better printing results.

Procedure

 Windows 7
From [Start] menu, click [Control Panel] → [Hardware and Sound] → [Devices and 
Printers].
Windows Vista
From [Start], click [Control Panel] → [Hardware and Sound] → [Printers].
Windows XP
From [Start], click [Control Panel] → [Printers and Other Hardware] → [Printers and 
Faxes].

  Right-click [Roland MPX-90].
 Click [Printing Preferences].

Setting Window for METAZA driver ap-
pears. 

  Click the [Image Correction] 
tab.

 For [Material], select a custom 
material (settings a through d).

 Select print Mode.
 METAZA Driver online help ([Correction] 
tab)

 Click [Details].
The [Details] window appears.

Text
When you want to print text and other im-
ages with clear outlines
Photo
When you want to print photographs and 
other images with gradation
HighResolution
When you want to express small text and 
small patterns clearly
Others
When you want to make the resolution set-
ting and other settings of an image



93Chapter 5 Maintenance and Adjustment

5-3 Composition Registration and Striking-force Adjustment

  Enter a name for the composi-
tion you’re registering.

 Enter [Speed/Impact]
The printing results vary according to the 
hardness of the material. Adjust to match 
the material. 
 METAZA Driver online help ("[Correction] 
tab" > "[Material Details] dialog box")

 Making the [advance] setting
[Advance] is available only when Print 
Mode is [Other].
 METAZA Driver online help ("[Correction] 
tab" > "[Material Details] dialog box")

 Click [OK].
[Advance] window close.

Materials and Values of Impact (Reference values)*
Material Impact--MIN Impact--MAX

Brass or Copper 200 350 to 450
Iron or Stainless steel 200 400 to 500

Titanium 200 500 to 600

* The coating of a coated material may come off when the stamping force is too strong. If the coating comes 
off, it may cause a malfunction. Adjust the print impact so that the coating will not come off.

Continue on the next page

OutputResolution
You can specify the number of dots per inch.
Drafting
You can skip image information in increments of one 
dot.

Impact--MIN
You can set the minimum value of print impact for an image.
Raise the value when dark areas of the image are not struck.
Lower the value when dark areas of the image are whitish or 
when overall striking is too forceful.
Impact--MAX
You can set the maximum value of print impact for an image.
Raise the value when bright areas of the image are struck with 
too little force or when overall striking is too weak.
Lower the value when bright areas of the image are struck with 
too much force.
Vector Impact
You can set the maximum value of print impact for a line.
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 Click [OK]. 
METAZA Driver setting window closes.

This is the end of registration of a material and the striking force suitable for it. To obtain printing results of 
higher quality, repeat to perform test print or to strike a same material, and adjust the value of print impact, 
etc. based on the print results.
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5-4 Adjustment of the Origin-point Location

Adjusting the Location of the Machine's Origin Point
The origin point of the machine must be the center of the scale on the table. You can check the origin-point 
location by printing calibration data. Adjust the origin point if it is displaced.
Prepare a plate-shaped material larger than 20 millimeters square.

1. Print calibration data.

 Switch on the power to the machine.
 P. 30, "Switching On the Power"

 Mount material.
Set material using the adhesive sheet and table.
Be sure to use the head cap.
 P. 36, "Loading Material Using the Adhesive Sheet"

 Start METAZAStudio.
 P. 44, "Starting METAZAStudio"

  Click .
 For [Look in], select the [Sam-

ples] folder in the [METAZAStudio] 
folder*. 
* The folder where METAZAStudio is 
installed

 Select [Axis.mzs]
 Click [Open].

 Start printing.
 P. 52, "Starting Printing"
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2. Measure the displacement of Origin-point Location and type in the correction values.

 Measure and note down the offset 
between the centerline on the 
table scale and the crossed lines 
on the material.
In the example shown in the figure, the 
[Width] value is displaced by 0.5 mm in 
the positive direction and the [Length] 
value is offset by 0.5 mm in the negative 
direction.

 Windows 7
From [Start] menu, click [Control Panel] → [Hardware and Sound] → [Devices and 
Printers].
Windows Vista
From [Start] menu, click [Control Panel] → [Hardware and Sound] → [Printers].
Windows XP
From [Start] menu, click [Control Panel] → [Printers and Other Hardware] → [Printers 
and Faxes].
The [Printers] folder opens.

 Right-click [Roland MPX-90].
Click [Printing Preferences].
The setting window of METAZA Driver 
appears.

Center line

Center

Positive direction 
for [Length]

Positive direction 
for [Width]

Material
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5-4 Adjustment of the Origin-point Location

  Click the [Material] tab.
 In the width and length fields 

for [Offset], enter the displace-
ment values you noted in step 
.
In the case of the figure in step, enter 
-0.5 in [Width] and 0.5 in [Length].

 Click [OK].
The window closes.

When the setting window of METAZA Driver for METAZAStudio is displayed, the values for any settings made 
there are temporary, and are not saved.

 P. 83, "Keeping the settings of METAZA Driver"
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5-5 The Replacement of the Head Cap

The Replacement Cycle for the Head Cap
When the head cap becomes worn away as shown in the figure below, it is time for replacement. Replace the 
head cap with a new one appropriately.
The degree of wear may vary according to printing conditions. In particular, printing that makes extensive use 
of island fill and other line-drawing operations on materials such as aluminum results in especially rapid wear 
because of the extensive unevenness of the material surface. Periodically check the state of the head cap to 
ensure that it is replaced as often as needed.
 P. 36, "Loading Material Using the Adhesive Sheet," p. 41, "Loading Material Using the Center Vise"

Head cap which 
needs to be replaced

Tabs

Tabs

Abraded
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The Replacement Cycle for the Head
MPX-90 Head Manager shows the amount of pin usage.
If the indicator for the pin you're using is red, then replace it with a new head. If attractive printing is impossible 
or printed images are uneven even though the scale is not red, then change to a new head.
 P. 91, "Adjusting the Striking Force of the Pin," p. 105, "The printed image is unattractive," p. 106, "The image is 
uneven"

A General Guide of Head Life

About 4,000 plates can be printed under the following conditions.
Conditions of Use 
Material used : MD-NI (Roland nickel-plated plate)
Printing area : 30 mm (1.1 in.) X 23 mm (0.9 in.)
Print Mode : Photo
Printing rate : 35% (25,000 dots per plate)
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How to Replace the Head
MPX-90 Head Manager is used for the head replacement operation.
The pattern shown in the figure is struck during the head replacement operation. You need to prepare a test 
print material (brass), which is supplied with a replacement head (MPH-90), or a material equal to or larger 
than 60 mm (2.3 in.) x 60 mm (2.3 in.).
A replacement head is sold separately. Consult your authorized Roland DG Corp. dealer.
 Do not stop the replacement operation halfway.
 Do not use the head of which the marking pin is worn out.
 Do not use the head which is detached from the machine.

Procedure

 From [Start] menu, click [All Programs] (or [Programs]) → [MPX-90 Head Manager] → 
[MPX-90 Head Manager].
MPX-90 Head Manager starts.

 Switch on the power to the machine.
 P. 30, "Switching On the Power"

 Click [Readjust Pin].
Follow the on-screen instructions to 
perform adjustment for the pin.

Set material using the adhesive sheet 
and table.

  P. 36, "Loading Material Using the Adhesive 
Sheet"
Print the adjustment pattern using the 
head cap.

  P. 36, "Loading Material Using the Adhesive 
Sheet"
If the adjustment pattern fails to be 
printed, see the sections given below.

  P. 104, "The printed location isn't where 
desired," p. 105, "Striking is performed, but 
nothing is printed"

Adjustment 
pattern
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 When you have finished, click 
.

The window closes.
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The power supply light is blinking.

Do you turn ON the power as the head position 
is set?
If the power is turned ON as the head position is set, the 
power supply light blinks immediately after the initial op-
eration is completed. If the head is set at an inappropriate 
position in relation to the surface height of the material, 
the surface of the material may be scratched and/or the 
marking pin may be damaged. To prevent these failures 
from occurring, the power supply light blinks. 
Loosen the knob counterclockwise once and reset the 
setting of the head position. After resetting it, tighten the 
knob again. Press the Power/Movement button, and the 
power supply light stops blinking and is lights.

If you do not use the head cap, do you adjust 
the head position based on the surface height 
of the material?
Turn OFF the power. Stop printing if it is underway.
In the case that you perform printing without using the 
head cap, if the head position is lower than the surface 
height of the material, the tip of the head comes into con-
tact with the surface of the material, and the power supply 
light blinks. Adjust the head position to an appropriate 
position based on the surface height of the material and 
secure the head firmly with the knob.
 P. 31, "Switching Off the Power," p. 36, "Loading Material Using 

the Adhesive Sheet," p. 41, "Loading Material Using the Center 

Vise," p. 54, "Stopping Printing Operations"

Do you lift the head when you turn ON the 
power?
Turn OFF the power. 
When you lift the head to the topmost, the machine 
considers that the surface height of the material is out 
of the print conditions, and the power supply light blinks. 
Be sure to handle the machine in accordance with User’s 
Manual.
P. 31, "Switching Off the Power" 

Is a change in the height of the print surface 
too large?
Stop printing.
If a change in the height of the print surface is too large, 
the power supply light blinks. Check the conditions of 
printable materials and select a material again.
 P. 33, "Preparing Material to Print," p. 54, "Stopping Printing 

Operations"

Do you set a material without using the supplied 
table (or the center vise)?
Turn OFF the power. Stop printing if it is underway.
If you set a material of which surface height is low without 
using the supplied table (or the center vise), the machine 
considers that the surface height of the material is out of 
the conditions of the printable materials, and the power 
supply light blinks. Make sure to set a material using the 
supplied table (or the center vise).
 P. 31, "Switching Off the Power," p. 36, "Loading Material Using 

the Adhesive Sheet," p. 41, "Loading Material Using the Center 

Vise," p. 54, "Stopping Printing Operations"

Is the knob loosened?
Stop printing.
If the knob becomes loose in the case that the head cap 
is not used, the head position does not match the surface 
height of the material, and consequently the power supply 
light blinks. When you set the head position, make sure 
to tighten the knob firmly.
 P. 36, "Loading Material Using the Adhesive Sheet," p. 41, 

"Loading Material Using the Center Vise," p. 54, "Stopping 

Printing Operations"

The machine doesn't run even when printing data is sent.

Is the power switched on?
Make sure the Power/Movement button light is on. If it 
is dark, press the Power/Movement button to switch on 
the power. 

 P.30, "Switching On the Power"

Is the power cord connected correctly? 
If it is not connected correctly, refer to the page indicated 
below and connect it properly. 

 P. 23, "Cable Connections"

Is the cable used for the connection to the 
computer connected correctly?
Check if the connection cable is disconnected.

The printed location isn't where desired

Is the material loaded at the correct location?
If striking is being performed at a location other than 
where the material is loaded, then reload the material.

6-1 What to Do If
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 P. 36, "Loading Material Using the Adhesive Sheet," p. 41, 

"Loading Material Using the Center Vise"

Is the origin point of the machine displaced?
The center of the table scale may not coincide with the 
machine's printing origin point. The origin point of the 
machine must be the center of the scale on the table. You 
can check the origin point location by printing calibration 
data. To correct displacement between the scale center 
and the printing origin point.

 P. 95, "Adjustment of the Origin-point Location"

Striking is performed, but nothing is printed.

Is the material to be printed in line with the 
parameters for printable material?
Prepare and use printable material.

 P. 33, "Preparing Material to Print"

If you’re not using a head cap, does the head 
position match the surface height of the mate-
rial in the case that you do not use the head 
cap?
Check if the head position matches the surface height of 
the material in the case that you do not use the head cap. 
Printing cannot be performed if the head position does 
not match the height position of the material. Adjust the 
head position and then tighten the knob firmly.

 P. 36, "Loading Material Using the Adhesive Sheet," p. 41, 

"Loading Material Using the Center Vise"

Is the marking pin bent or broken?
When nothing is printed, and changing the location 
where the material is loaded, the parameters for the ma-
terial, or the height of the head unit does not correct the 
problem, then the marking pin may be bent or broken. 
Try changing to an unused marking pin and carry out 
test printing. If you can print with the new marking pin, 
it means the marking pin you had been using is bent or 
broken. Continue using the new marking pin.

 P.100,  "How to Replace the Head"

The printed image is unattractive.

Are the settings for the material in the driver's 
setting window correct?
Choose the composition of the loaded material. 
Even if the composition of the material is the same, 
the hardness of the printed surface may vary greatly 
depending on the casting method, the composition of 
impurities, the presence of plating, and so on. In such 
cases, perform fine adjustment of the striking force to 
match the material.

 P. 92, "Registering a Composition and Adjusting the Striking 

Force"

Is the image printed clearly?
If the image is not printed clearly, adjust the brightness of 
the image. Perform printing while increasing the bright-
ness of [Gamma] or [Brightness] in the driver's setting 
window a little at a time. At this time, leave the material 
loaded and perform overstriking at the same location. 
Continue changing settings and performing printing 
until you obtain the darkness you want.

 P. 75, "Checking the Finished Results in the Preview Win-

dow"

Are grayscale tones printed clearly?
When grayscale tones are indistinct, go to the setting 
window for the driver (“Advanced” at the [Image Correc-
tion] tab) and adjust the force of striking. Perform printing 
while leaving the value for [Impact--MAX] unchanged 
and increasing the value for [Impact--MIN] a little at a 
time. At this time, leave the material loaded and perform 
overstriking at the same location. Continue changing the 
settings in the driver's setting window and performing 
printing until you obtain the darkness you want.

 P. 92, "Registering a Composition and Adjusting the Striking 

Force"
More Information about Overstriking
The various setting values determined with overstriking 
are effective only when performing overstriking under 
identical conditions. The same results are not necessarily 
obtained when printing is performed with a new piece of 
material with only the conditions made the same, without 
performing overstriking.

Is the marking pin worn?
Attractive printing may be impossible if the marking 
pin becomes worn. Adjust the pin or change it to a new 
one.

Not bent or 
broken

Bent or broken Bent or broken
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The image is always faint at the same location.

Is the height displacement for the printed sur-
face excessive?
If the image is always faint at the same location even 
though you’re performing printing using a head cap, 
the height displacement for the printed surface may 
be excessive. Recheck the parameters of materials that 
the machine can print and select material that meets 
the parameters. Also, image quality is not assured when 
printing photographic data on a curved surface with 
this machine.

  P. 33, "Preparing Material to Print"

Have you tried to adjust the levelness of the 
machine?
If you’re not using a head cap If the image is often faint at 
the same location, such as near the front right area of the 
table, then adjusting the levelness of the machine may 
improve the image quality. Please note that this is not ef-
fective when unevenness in the image is unrelated to the 
printing location, such as when uneven areas vary from 
one piece of material or image to another. We recom-
mend using a head cap whenever such use is possible.

 P. 32, "Head Caps"

Procedure
1. Using an adhesive sheet, load a piece of 
included test-use printing material at the center 
of the table.
If the included material has been used up, then prepare 
a piece of material that is larger than 60 mm (2.3 in.) and 
has a smoothness of 0.05 mm (0.002 in.) or less. Make a 
print without using the head cap.

 P. 36, "Loading Material Using the Adhesive Sheet"
2. Go into the [Printers] folder.
3. Right-click the [Roland  MPX-90] and open the 
setting screen for METAZA driver. Click [Printing 
Preferences].
The setting window for METAZA driver appears.
4. Click the [Option] tab.
5. Click [Test print].
The test pattern is printed on the material.
6. Use the scale to read and note down loca-
tions where the test pattern is not continuous 
or not visible.
Note down the values in all four directions (front, back, 
left, and right).

 P. 90, "Checking the State of the Marking Pin," p.100, "How to 

Replace the Head" 

The image is uneven.

Is the printed surface slightly uneven?
If no head cap is attached, then attach a head cap and 
perform printing. If you’re using material that can be dam-
aged by printing with the head cap attached, then replace 
it with material that has a level printing surface.

 P. 32, "Head Caps," p.33, "Preparing Material to Print"

Is the printed surface at an angle?
If no head cap is attached, then attach a head cap and 
perform printing. If you’re using material that can be dam-
aged by printing with the head cap attached, then replace 
it with material that has a level printing surface.

 P. 32, "Head Caps," p.33, "Preparing Material to Print"

Is the image darkness uneven?
Performing overstriking with the material left loaded 
at the same location may improve the image quality. 
Try performing overstriking with different settings for 
[Gamma], [Brightness], or [Contrast] in the driver's set-
ting window.

 P. 75, "Checking the Finished Results in the Preview Win-

dow"

Was bidirectional printing performed?
Bidirectional printing can shorten the printing time, but 
the image quality may suffer. If this happens, go to the 
driver's setting window and clear the selection for [Bidi-
rection], then redo printing.

 METAZA Driver online help ([Material] tab)

Is the marking pin worn?
Attractive printing may be impossible if the marking 
pin becomes worn. Check the state of the marking pin. 
If the marking pin becomes worn, replace the head with 
a new one.

 P. 90, "Checking the State of the Marking Pin," p. 100, "How 

to Replace the Head" 
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7.
 Select [Correct slope] 
 Enter the scale values you noted into the 

driver.
 Click [OK]

Installation for METAZA driver is Impossible

If installation quits partway through, or if the wizard does 
not appear when you make the connection with a USB 
cable, take action as follows.

Windows 7
1.Connect the machine with the computer via a 
USB cable, and turn on the machine.
2. If the [Found New Hardware] window appears, 
click [Cancel] to close it. Make sure that all USB 
cables connected with the printers except this 
machine are disconnected.
3. Click the [Start] menu, and right-click [Com-
puter]. Click [Properties].
4. Click [Device Manager]. When [User Account 
Control] appears, click [Continue].
The [Device Manager] appears.
5.  At the [View] menu, click [Show hidden de-
vices].
6. In the list, find and double-click [Printers] or 
[Other device]. When the model name you are 
using or [Unknown device] appears below the 
item you selected, click it to choose it.
7. Go to the [Action] menu, and click [Unin-
stall].
8.In the [Confirm Device Uninstall] window, click 
[OK] without selecting [Delete the driver software 
for this device]. Close [Device Manager].
9. Detach the USB cable connected to the 
printer, and the restart Windows.
10. Uninstall METAZA Driver.
 Carry out the steps from step 3 in page 104, ”Uninstalling 

METAZA driver  Windows Vista” to uninstall METAZA Driver.
11. Install the driver again according to the pro-
cedure in page 25, “Installing METAZA driver.

Windows Vista
1.Connect the machine with the computer via a 
USB cable, and turn on the machine.
2. If the [Found New Hardware] appears, click 
[Cancel] to close it. Disconnect any USB cables 
for printers or other such equipment other than 
this machine.
3. Click the [Start] menu, then right-click [Com-
puter]. Click [Properties].
4. Click [Device Manager]. The [User Account 
Control] appears, click [Continue].
The [Device Manager] appears.
5.  At the [View] menu, click [Show hidden de-

RightLeft

Back

Front
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vices].
6. In the list, find [Printers] or [Other device], then 
double-click it. When the model name you are 
using or [Unknown device] appears below the 
item you selected, click it to choose it.
7. Go to the [Action] menu, and click [Unin-
stall].
8.In "Confirm Device Uninstall" window, select 
[Delete the driver software for this device.], then 
click [OK]. Close the [Device Manager].
9. Detach the USB cable connected to the 
printer, and the restart Windows.
10. Uninstall METAZA Driver.
 Carry out the steps from step 3 in page 104, ”Uninstalling 

METAZA driver  Windows Vista” to uninstall METAZA Driver.
11. Install the driver again according to the pro-
cedure in page 25, “Installing METAZA driver.

Windows XP
1.Connect the machine with the computer via a 
USB cable, and turn on the machine.
2. If the [Found New Hardware Wizard] appears, 
click [Finish] to close it. Disconnect any USB 
cables for printers or other such equipment other 
than this machine.
3. Click the [Start] menu, then right-click [My 
Computer]. Click [Properties].
4. Click the [Hardware] tab, then click [Device 
Manager].
The [Device Manager] appears.
5. At the [View] menu, click [Show hidden de-
vices].
6. In the list, find [Printers] or [Other device], then 
double-click it. When the model name you are 
using or [Unknown device] appears below the 
item you selected, click it to choose it.
7. Go to the [Action] menu, and click [Unin-
stall].
8. In "Confirm Device Uninstall" window, click 
[OK].
9. Close the [Device Manager] and click [OK].
10. Detach the USB cable connected to the 
printer, and the restart Windows.
11. Uninstall METAZA driver.
 Carry out the steps from step 3 in page 104, ”Uninstalling 

METAZA driver  Windows Vista” to uninstall METAZA Driver.
12. Install the driver again according to the pro-
cedure in page 25, “Installing METAZA driver.

Uninstalling METAZA driver

When uninstalling METAZA driver, perform following 
operation.

Windows 7
1. Switch off the power to the machine, then de-
tach the connector cable between the machine 
and the computer.
2. Log on to Windows as “Administrators” 
right.
3. From the [Start] menu, click [ControlPanel], 
and then click [Uninstall a program].
4. Click the driver for the machine to delete to 
select it, then Click [Uninstall].
5. A message prompting you to confirm deletion 
appears. Click [Yes].
6. From the [Start] menu, choose [All Programs], 
then [Accessories], then [Run], and then click 
[Browse].
7. Choose the name of the drive or folder where 
the driver is located. (*)
8. Select "SETUP.EXE" and click [Open], then 
click [OK].
9. The [User Account Control] appears, click 
[Allow].
The Setup program for the driver starts.
10. Click [Uninstall] to choose it. Select the ma-
chine to delete, then click [Start].
11. If it is necessary to restart your computer, 
a window prompting you to restart it appears. 
Click [Yes].
The uninstallation finishes after the computer restarts.

(*) When using the CD-ROM, specify the folder as shown 
below (assuming your CD-ROM drive is the D drive).
D:\Drivers\WIN7X64 (64-bit version)
D:\Drivers\WIN7X86 (32-bit version)
If you're not using the CD-ROM, go to the Roland DG Corp. 
website (http://www.rolanddg.com/) and download the 
driver for the machine you want to delete, then specify 
the folder where you want to expand the downloaded 
file.

Windows Vista
1. Switch off the power to the machine, then de-
tach the connector cable between the machine 
and the computer.
2. Log on to Windows as “Administrators” 
right.
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3. From the [Start] menu, click [Control Panel]. 
From the [Hard-ware and Sound] group, click 
[Printer].
[Printer] folder opens.
4. Click the model name’s icon you are using. 
From the [Organize] menu, click [Delete]. The 
[User Account Control] appears, click [Con-
tinue].
5. A message prompting you to confirm deletion 
appears. Click [Yes].
6. In the [Printers] folder, right-click any location 
where no printer icon is present. From the [Run 
as administrator] menu, select [Server Proper-
ties]. The [User Account Control] appears, click 
[Continue].
7. Click the [Drivers] tab, then from the [Installed 
printer drivers] list, choose the machine to de-
lete.
Click [Remove].
8. The [Remove Driver And Package] appears, 
select [Remove driver and driver package]. 
Click [OK].
9. When the prompt message appears, click 
[Yes].
10.  The package and driver to delete are 
displayed. Make sure that what is displayed 
is the machine you want to delete, then click 
[Delete].
11. The items that have been deleted are dis-
played. Click [OK].
12. Click [Close] on [Remove Driver And Pack-
age] window.
13. From the [Start] menu, choose [All Pro-
grams], then [Accessories], then [Run], and then 
click [Browse].
14. Choose the name of the drive or folder where 
the driver is located. (*)
15. Select "SETUP.EXE" and click [Open], then 
click [OK].
16. The [User Account Control] appears, click 
[Allow].
The Setup program for the driver starts.
17. Click [Uninstall] to choose it. Select the ma-
chine to delete, then click [Start].
18. If it is necessary to restart your computer, 
a window prompting you to restart it appears. 
Click [Yes].
The uninstallation finishes after the computer restarts.

(*) When using the CD-ROM, specify the folder as shown 

below (assuming your CD-ROM drive is the D drive).
D:\Drivers\WINVISTAX64 (64-bit version)
D:\Drivers\WINVISTAX86 (32-bit version)
If you're not using the CD-ROM, go to the Roland DG Corp. 
website (http://www.rolanddg.com/) and download the 
driver for the machine you want to delete, then specify 
the folder where you want to expand the downloaded 
file.

Windows XP
1. Switch off the power to the machine, then de-
tach the connector cable between the machine 
and the computer.
2. Log on to Windows as “Administrators” 
right.
3. From the [Start] menu, click [Control Panel]. 
Click [Printers and Other Hardware], then click 
[Printers and Faxes].
4. Click the model name’s icon you are using. 
From the [File] menu, choose [Delete].
5. A message prompting you to confirm deletion 
appears. Click [Yes].
6. Go to [File] and select [Server Properties].
7. Click the [Driver] tab, then from the [Installed 
printer drivers] list, choose the machine to de-
lete.
8. Click [Delete]. When the prompt message 
appears, click [Yes].
9. From the [Start] menu, select [Run], then click 
[Browse].
10. From the [File Locations] list, choose the 
name of the drive or folder where the driver is 
located. (*) 
11. Select "SETUP.EXE" and click [Open], then 
click [OK].
The Setup program for the driver starts.
12. Click [Uninstall] to choose it. Select the ma-
chine to delete, then click [Start].
13. If it is necessary to restart your computer, 
a window prompting you to restart it appears. 
Click [Yes].
The uninstallation finishes after the computer restarts.

(*) When using the CD-ROM, specify the folder as shown 
below (assuming your CD-ROM drive is the D drive).
D:\Drivers\WINXPX64 (64-bit version)
D:\Drivers\WINXPX86 (32-bit version)
If you're not using the CD-ROM, go to the Roland DG Corp. 
web-site (http://www.rolanddg.com/) and download the 
driver for the machine you want to delete, then specify 
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the folder where you want to expand the downloaded 
file.
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Attach the retaining materials to the machine.
When moving the machine, be sure to attach the retaining materials. Moving the machine without attaching 
the retaining materials may result in damage to the machine.

Procedure

  Switching on the power.
 P. 30, "Switching On the Power"

 Detach the table (or the center 
vise).

 Attach a head cap to the tip of 
head. 

 Switching off the power.
 P. 31, "Switching Off the Power"

Head cap

Head

Hold the head.
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 Hold down the Power/Movement 
button for ten seconds or longer.
The head moves as shown in the figure.

 Loosen the knob

  Lift up the head.
 Tighten the knob as lifting the 

head.

Power / Movement button

Loosen
Knob

Tighten

Lift the head.

Head

Adjust the position of the 
knob so that its center will 
come above this marking.
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 Unplug the cables.

 Attach the retaining materials.
The machine is to be secured at three points (with 5 screws). Attach all the retainers and wind up the 
screws with the provided hexagonal wrench.

 Close the cover and repack the machine in the original package.

Screw

Retainer

Retainer

Screws

Hexagonal wrench

Screws
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Serial Number
This is required when you seek mainte-
nance, servicing, or support. Never peel off 
the label or let it get dirty.

Power Rating
Use an electrical outlet that meets the 
requirements for voltage, frequency, and 
amperage given here.

Power Rating
Use an electrical outlet that meets the 
requirements for voltage, frequency, and 
amperage given here.
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Main Unit Specifications

MPX-90 
Printable material Gold, silver, copper, platinum, brass, aluminium, iron, stainless steel, etc. 

(Vickers hardness [HV] of the printing surface must be 200 or less.) 
Loadable material size Maximum 100 mm (width) x 200 mm (length) x 40 mm (thickness), or 200 

mm (width) x 100 mm (length) x 40 mm (thickness)
(3.9 in. x 7.9 in. x 1.5 in.), or (7.9 in. x 3.9 in. x 1.5 in.)

Printing area 80 mm x 80 mm (3.1 in. x 3.1 in.)
Resolution 529 dpi (High resolution), 353 dpi (Photo), 265 dpi (Text), 1058 dpi (Vec-

tor)
Printing direction Unidirectional printing or bidirectional printing (Selectable with Windows 

driver)
Printing speed (Default) 50 mm/sec (1.9 in./sec) (Photo), 33 mm/sec (1.2 in./sec) (High resolution/

Text),
24 mm/sec (0.94 in./sec) (Vector)

Interface USB interface (compliant with Universal Serial Bus Specification Revision 
1.1)

Power requirements Dedicated 
AC adapter

 AC 100V to 240V ±10% 50/60Hz

Machine DC 19 V 1.6 A
Power consumption Approx. 24W
Acoustic noise level Under 70 dB (A) 
Operation temperature 10 to 30°C (50 to 86°F)
Operation humidity 35 to 80% (no condensation)
External dimensions 286 mm (W) x 383 mm (D) x 308 mm (H)

(11.3 in. (W) x 15.1 in. (D) x 12.2 in. (H))
Weight 10.8 kg (23.8 lb.)
Accessories AC adapter, power cord, test-use printing material, USB cable, CD-ROM, 

user's manual, etc.

System Requirements for USB Connection

Computer A model preinstalled with the 32- or 64-bit edition of Windows XP, Windows Vista, or 
Windows 7, or a model upgraded from the one preinstalled with Windows XP or any 
later operation system than Windows XP

USB cable Use the included USB cable.
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Please read this Agreement before unpacking the media.
Software license agreement

Roland DG Corporation (hereinafter referred to as the “Company”) shall grant you a non-transferable, nonexclusive right 
to use the Software supplied with this Agreement, on the condition that you agree to the following provisions.
If you agree to the following provisions, you should unpack the media on which the Software is recorded, or simply 
click the button or other indicator that you agree to the following provisions. By doing so, this Agreement shall be 
concluded.
If you do not agree with the following provisions, do not unpack the media. Or, you can click the button or other 
indicator that you do not agree to the following provisions of this Agreement. In this case, a license is not granted 
and you cannot use the Software.

1. Definition
The “Software” includes the software program and related files supplied with this Agreement and the related software 
programs and files distributed through the Internet and other services.

2. Ownership
All the ownership, copyright and other intellectual property rights of the Software, trademark, and related docu-
ments shall belong to the Company.

3. Terms and conditions
(1) You are authorized to use the Software on one computer.
(2) You are allowed to create a backup copy of the Software.
The right to keep the Software and the backup copy of the Software continues to belong to the Company, but the 
right to the media on which the backup copy of the Software is recorded does not belong to the Company.

4. Forbidden items
(1) This copy of the Software, or a backup copy of the Software, must not be used on multiple computers at the same 
time, on a network, the Internet, or on other computers through any other means of distribution.
(2) The Software shall not be reverse engineered, decompiled or reverse assembled.
(3) The rights to the Software cannot be transferred, assigned, lent, loaned or licensed to a third party in any case, 
regardless of whether this Agreement has been terminated or cancelled.

5. Termination
(1) The Company can cancel this Agreement and require you to discontinue use of the Software if you breach any 
provision of this Agreement or if you infringe on the ownership, copyright, or other intellectual property rights of 
the Company. (2) This Agreement shall be automatically terminated when you stop using the Software.
(3) If this Agreement is terminated or cancelled, you must return your copy of the Software to the Company, or discard 
it as soon as practicable, at your own expense.

6. Guarantee
(1) The Company shall not guarantee that the quality or functionality of the Software will satisfy any purpose that 
you may have in mind.
(2) The Company shall not accept any responsibility for the results obtained from using the Software.
(3) The Company shall not accept any responsibility for any loss which might be caused as a result of your exercising 
the rights granted under this Agreement.
(4) The specifications for the Software are subject to change without prior notice.

7. Governing Law
This Agreement shall be governed by the laws of Japan.
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